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Preface
The PIC18F56Q24 Curiosity Nano evaluation kit (EV01E86A) is a hardware platform to evaluate the PIC18-Q24
family microcontrollers. This board has the PIC18F56Q24 microcontroller (MCU) mounted.

The Curiosity Nano series of evaluation boards include an on-board debugger. No external tools are necessary
to program and debug the PIC18F56Q24.

• PIC18F56Q24 Curiosity Nano website - Kit information, latest user guide, and design documentation.
• PIC18F56Q24 website - Find documentation, data sheets, sample, and purchase microcontrollers.
• Code examples on MPLAB® Discover - Get started with code examples.
• PIC18F56Q24 Curiosity Nano on Microchip Direct - Purchase this kit on Microchip Direct.
• PIC18F56Q24 Curiosity Nano Schematics - Board schematics and history.
• PIC18F56Q24 Curiosity Nano Altium Project - Latest project revision.
• PIC18F56Q24 Curiosity Nano Design Documentation - Production files for every revision.

 PIC18F56Q24 Curiosity Nano User Guide
 PIC18F56Q24 Curiosity Nano

http://www.microchip.com/DevelopmentTools/ProductDetails.aspx?PartNO=EV01E86A
https://www.microchip.com/wwwproducts/en/PIC18F56Q24
https://mplab-discover.microchip.com/v2?dsl=q24
http://www.microchipdirect.com/ProductSearch.aspx?Keywords=EV01E86A
https://ww1.microchip.com/downloads/aemDocuments/documents/MCU08/ProductDocuments/BoardDesignFiles/PIC18F56Q24-Curiosity-Nano-Schematics.pdf
https://ww1.microchip.com/downloads/aemDocuments/documents/MCU08/ProductDocuments/BoardDesignFiles/PIC18F56Q24-Curiosity-Nano-Altium-Project.zip
https://ww1.microchip.com/downloads/aemDocuments/documents/MCU08/ProductDocuments/BoardDesignFiles/PIC18F56Q24-Curiosity-Nano-Design-Documentation.zip
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1. Features and Pinout
Features of MCU and Curiosity Nano, Board Layout Picture, Board Block Diagram, Pinout Diagram

1.1 PIC18F56Q24 Key Features
The PIC18-Q24 microcontroller family is ideal for sensor-interfacing, real-time control, and
communication applications. This family introduces the Programming and Debugging Interface
Disable module to increase code and data protection.

• Multi-Voltage I/O (MVIO) interface with multiple pins powered by VDDIO2

• Advanced Code Security to support users in data protection and bootloader applications using
the Programming and Debugging Interface Disable (PDID) module

• Storage Area Flash (SAF) one-time programmable memory
• Memory Access Partition (MAP)
• Direct Memory Access (DMA) capabilities
• Vectored interrupt controller with fixed latency for handling interrupts
• 10-bit 300 ksps ADC with Computation (ADCC) for responsive sensor designs
• 8-bit Signal Routing Port module to interconnect digital peripherals without using external pins
• UART with support for asynchronous, DMX and LIN protocols,
• The Device Information Area (DIA) stores factory calibration values to help improve temperature

sensor accuracy

1.2 Board Features
• PIC18F56Q24 Microcontroller
• USB Type-C® Connector
• One Yellow User LED
• One Mechanical User Switch
• One green power and status LED
• Footprint for 32.768 kHz Crystal
• On-Board Debugger support in Microchip MPLAB® X IDE:

– Board identification
– Virtual serial port (CDC)
– Programming and debugging
– One debug GPIO channel (DGI GPIO)

• USB Powered
• Adjustable Target Voltage:

– MIC5353 LDO regulator controlled by the on-board debugger
– 1.8–5.1V output voltage (limited by USB input voltage)
– 500 mA maximum output current (limited by ambient temperature and output voltage)
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1.3 Board Overview
Figure 1-1. PIC18F56Q24 Curiosity Nano Board Overview
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1.4 Block Diagram
Figure 1-2. PIC18F56Q24 Curiosity Nano Board Block Diagram
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1.5 Pinout
All the PIC18F56Q24 I/O pins are accessible at the edge connectors on the board. The image below
shows the board pinout.
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Figure 1-3. PIC18F56Q24 Curiosity Nano Pinout
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Info:  Peripheral signals shown in the image above, such as UART, I2C, SPI, ADC, PWM, and
others, are shown at specific pins to comply with the Curiosity Nano Board standard. These
signals can usually be routed to alternate pins using the Peripheral Pin Select (PPS) feature
in the PIC18F56Q24.

1.6 Preprogrammed Application
The PIC18F56Q24 mounted on the Curiosity Nano Evaluation Kit is pre-programmed with an
example application ready featuring four different programs selectable through a command line
interface.
• LED blinker. The microcontroller starts with this program running.
• Push the button (SW0) to turn on the LED (LED0)
• Ramp on Data Visualizer
• Temperature sensor reading

To get started with the application, find the user guide, code, and hex files for this application
available online on GitHub.
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https://github.com/microchip-pic-avr-examples/pic18f56q24-cnano-demo-fw
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2. Getting Started
Getting started resources for the PIC18F56Q24 Curiosity Nano board in the MPLAB Tools Ecosystem.

2.1 Getting Started Now with PIC®
Are you new to using PIC microcontrollers (MCUs)? Microchip MCUs are supported by our
comprehensive MPLAB® development ecosystem, which makes it easy to get your prototype up and
running and includes production-ready code generation tools. Try the interactive guide to find the
necessary resources: Get Started Now with PIC MCUs.

1. Examples: MPLAB Discover is a tool to help you find Microchip example projects. It offers
several ways to filter projects so that you can efficiently find a Microchip-tested example, as close
as possible to your application requirements, to use as a starting point for your development.

2. Configure: MCC Melody provides Libraries, Drivers, and Peripheral Libraries (PLIB) for the
development of embedded software for a range of supported Microchip MCUs, which are
configured using MPLAB® Code Configurator (MCC).

3. Develop: MPLAB X IDE (Integrated Development Environment), which is available for Windows,
Linux and macOS, also MPLAB® XC C Compilers.

4. Debug: With the MPLAB X IDE and/or the MPLAB Data Visualizer, the PIC18F56Q24 device
on the PIC18F56Q24 Curiosity Nano board is programmed and debugged by the on-board
debugger. Therefore, no external programmer or debugger tool is required.

5. Boards: The PIC18F56Q24 Curiosity Nano board is a supported part of the Curiosity Nano
Development Platform, which includes the Curiosity Nano Base for Click Boards™.

Tip: Have a look at this free Microchip University course.

The Curiosity Nano development platform is well
suited to rapid prototyping. This course will introduce
you to the defining features of the Curiosity Nano
platform and show you how it can be leveraged using
a new microcontroller or developing a new prototype.
This course includes an in-depth look at the on-board
debugger, which is central to the platform, and how
to use its various user interfaces to help you reach
your goals quicker.

2.2 How the Curiosity Nano Fits Into the MPLAB Tools Ecosystem

2.2.1 MPLAB X IDE Support for Curiosity Nano
When the board connects to the computer for the first time, the operating system will install the
driver software. The drivers for the board are included with MPLAB® X IDE. Once this is done, when
connecting the Curiosity Nano to a host PC via USB, if MPLAB X IDE is open, a Kit Window is opened
with several key links for that Curiosity Nano.

When creating a new project, the part number on the Curiosity Nano will be detected, as will the
debug tool.

https://www.microchip.com/en-us/products/microcontrollers-and-microprocessors/8-bit-mcus/pic-mcus/get-started-now
https://www.microchip.com/en-us/products/microcontrollers-and-microprocessors/8-bit-mcus/pic-mcus/get-started-now
https://mplab-discover.microchip.com/
https://www.microchip.com/en-us/tools-resources/configure/mplab-code-configurator/melody
https://onlinedocs.microchip.com/v2/keyword-lookup?keyword=MCC.MELODY.COMPONENT.REFERENCE&version=latest&redirect=true
https://www.microchip.com/en-us/tools-resources/configure/mplab-code-configurator
https://www.microchip.com/en-us/tools-resources/develop/mplab-x-ide
https://www.microchip.com/en-us/tools-resources/develop/mplab-xc-compilers
https://www.microchip.com/en-us/tools-resources/debug/mplab-data-visualizer
https://www.microchip.com/en-us/tools-resources/evaluation-boards/curiosity-nano
https://www.microchip.com/en-us/tools-resources/evaluation-boards/curiosity-nano
https://www.microchip.com/en-us/development-tool/AC164162
https://mu.microchip.com/rapid-prototyping-with-the-curiosity-nano-platform
https://mu.microchip.com/rapid-prototyping-with-the-curiosity-nano-platform
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Tip: 
• For the PIC18F56Q24 Curiosity Nano board, use MPLAB® X IDE version 6.15, device

family pack “PIC18F-Q_DFP” version 1.23.425, and tool pack “nEDBG_TP” version
1.13.715 or newer

• The latest device family packs are available through Tools > Packs in MPLAB® X IDE or
online at Microchip MPLAB® X Packs Repository. For more information on packs and
how to upgrade them, refer to the MPLAB® X IDE User’s guide - Work with Device Packs.

As shown in the image below, additional information about your Curiosity Nano can be seen in the
"Debug Tool" window once you click "Refresh Debug Tool Status".

https://packs.download.microchip.com/
https://onlinedocs.microchip.com/v2/keyword-lookup?keyword=MPLABX:PACKS&version=latest&redirect=true
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Tip: 
• If closed, reopen the Kit Window in MPLAB® X IDE through the menu bar Window > Kit

Window
• The 'How do I?' search bar often gives excellent results if you're new to MPLAB X IDE
• 'Debug main project" will start a debug session

Tip: 
• After clicking on 'Refresh Debug Tool Status,' you can see information such as MCU

Target Voltage
• What are Program- and Data-Break Points? MPLAB X IDE Advanced Debugging -

Breakpoints Demo
• Reference for example above - MCC Melody Timer0 Driver: 100 ms Timer, API Ref Code

2.3 MPLAB Data Visualizer Support for Curiosity Nano
The Curiosity Nano, via a USB/serial bridge, facilitates a connection between a UART on the Target
MCU and your computer's COM port. For example, you may use this to connect to the MPLAB Data
Visualizer or other terminal programs.

https://youtu.be/RVPOhPopujs?list=PLtQdQmNK_0DTsTgCR47l9l6HHQIb6b3-T
https://youtu.be/RVPOhPopujs?list=PLtQdQmNK_0DTsTgCR47l9l6HHQIb6b3-T
https://youtu.be/ZmpbrB6hAuE
https://onlinedocs.microchip.com/v2/keyword-lookup?keyword=SCF-PIC8-TIMER0-V1&version=latest&redirect=true
https://onlinedocs.microchip.com/v2/keyword-lookup?keyword=MPLAB_DATA_VISUALIZER&version=latest&redirect=true
https://onlinedocs.microchip.com/v2/keyword-lookup?keyword=MPLAB_DATA_VISUALIZER&version=latest&redirect=true
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Tip: References for the example Data Visualizer Plot- and Terminal-views above:
1. Plot View - DebugIO: DebugIO Hello World (Microchip University).
2. Plot View - Serial Port: MCC Melody Use Case Data Visualizer Run Time Use Case 1.
3. Terminal - Serial Port: MCC Melody UART Driver: LED Control Commands.

2.4 Using Pin-Headers
The edge connector footprint on the PIC18F56Q24 Curiosity Nano has a staggered design where
each hole is shifted 8 mil (~0.2 mm) off-center. The hole shift allows regular 100 mil pin headers to
be used without soldering on the board. The pin-headers can be used in applications like pin sockets
and prototyping boards without issues once they are firmly in place.

https://mu.microchip.com/visual-debugging-with-mplab-data-visualizer/695707
https://www.youtube.com/watch?v=80OA-Cw0F_k
https://www.youtube.com/watch?v=yfr8Jgwljh0
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Figure 2-1. Attaching Pin-Headers to the Curiosity Nano Board

Figure 2-2. Connecting to Curiosity Nano Base for Click boards™

Tip: 
• Start at one end of the pin-header and gradually insert the header along the length of

the board. Once all the pins are in place, use a flat surface to push them in.
• For applications using the pin-headers permanently, it is still recommended to solder

them in place
• Once the pin-headers are in place, they are hard to remove by hand. Use a set of pliers

and carefully remove the pin-headers to avoid damage to the pin-headers and PCB.
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3. On-Board Debugger
Features and interfaces of the on-board debugger for programming and debugging.

3.1 On-Board Debugger Overview
PIC18F56Q24 Curiosity Nano contains an on-board debugger for programming and debugging. The
on-board debugger is a composite USB device consisting of several interfaces:
• A debugger that can program and debug the PIC18F56Q24 in MPLAB® X IDE
• A virtual serial port (CDC) that is connected to a Universal Asynchronous Receiver/Transmitter

(UART) on the PIC18F56Q24 and provides an easy way to communicate with the target
application through terminal software

• A mass storage device that allows drag-and-drop programming of the PIC18F56Q24
• A Data Gateway Interface (DGI) for code instrumentation with logic analyzer channels (debug

GPIO) to visualize program flow

The on-board debugger controls a Power and Status LED (marked PS) on the PIC18F56Q24 Curiosity
Nano board. The table below shows how the different operation modes control the LED.

Table 3-1. On-Board Debugger LED Control
Operation Mode Power and Status LED

Boot Loader mode The LED blinks slowly during power-up

Power-up The LED is ON

Normal operation The LED is ON

Programming Activity indicator: The LED blinks slowly during programming/debugging

Drag-and-drop programming
Success: The LED blinks slowly for 2 sec.
Failure: The LED blinks rapidly for 2 sec.

Fault The LED blinks rapidly if a power fault is detected

Off The on-board debugger is powered down, the LED is OFF

Info: Slow blinking is approximately 1 Hz, and rapid blinking is about 5 Hz.

3.2 On-Board Debugger Connections
The table below shows the connections between the target and the debugger section. All the
connections between the target and the debugger are tri-stated when the debugger is not using
the interface. Hence, there are few contaminations of the signals, e.g., the pins can be configured to
anything the user wants.

Info: The 12-edge connections closest to the USB connector on Curiosity Nano boards
have a standardized pinout. The program/debug pins have different functions depending
on the target programming interface.

Table 3-2. On-Board Debugger Connections
Debugger Pin PIC18F56Q24 Pin Description

CDC TX RB4 UART RX USB CDC TX line

CDC RX RB5 UART TX USB CDC RX line
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...........continued
Debugger Pin PIC18F56Q24 Pin Description

DBG0 RB7 ICSPDAT Debug data line

DBG1 RB6 ICSPCLK Debug clock line

DBG2 RF3 SW0/GPIO0 Debug GPIO0/SW0

DBG3 RE3 MCLR Reset line

ID — — ID line for extensions

NC — — No connect

VBUS — — VBUS voltage for external use

VOFF — — Voltage Off input. Disables the target regulator
and target voltage when pulled low.

VTG — — Target voltage

GND — — Common ground

Figure 3-1. Curiosity Nano Debugger Pinout
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Tip: For the complete PIC18F56Q24 Curiosity Nano pinout, see the PIC18F56Q24 Curiosity
Nano Pinout.

3.3 Debugger USB Enumeration
The on-board debugger on the PIC18F56Q24 Curiosity Nano board appears as a Human Interface
Device (HID) on the host computer’s USB subsystem. The debugger supports full-featured
programming and debugging of the PIC18F56Q24 using MPLAB X IDE.

Remember: Keep the debugger’s firmware up-to-date. Firmware upgrades automatically
when using MPLAB X IDE.

3.4 Virtual Serial Port (CDC)
The virtual serial port (CDC) is a general purpose serial bridge between a host PC and a target
device.

3.4.1 Overview
The on-board debugger implements a composite USB device with a standard Communications
Device Class (CDC) interface, which appears on the host as a virtual serial port. Use the CDC to
stream arbitrary data between the host computer and the target in both directions: All characters
sent through the virtual serial port on the host computer will be transmitted as UART on the
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debugger’s CDC TX pin. The UART characters captured on the debugger’s CDC RX pin will be
returned to the host computer through the virtual serial port.

Figure 3-2. CDC Connection
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Info: The debugger’s CDC TX pin is connected to a UART RX pin on the target for receiving
characters from the host computer, as shown in the figure above. Similarly, the debugger’s
CDC RX pin is connected to a UART TX pin on the target for transmitting characters to the
host computer.

3.4.2 Operating System Support
On Windows® machines, the CDC will enumerate as Curiosity Virtual COM Port and appear in the
Ports section of the Windows Device Manager. The COM port number can also be found there.

Info: On older Windows systems, the CDC requires a USB driver. The MPLAB X IDE
installation include this driver.

On Linux® machines, the CDC will enumerate and appear as /dev/ttyACM#.

Info: tty* devices belong to the “dialout” group in Linux, so it may be necessary to become
a member of that group to have permission to access the CDC.

On Mac® machines, the CDC will enumerate and appear as /dev/tty.usbmodem#. Depending on
the terminal program used, it will appear in the available list of modems as usbmodem#.

Info: For all operating systems, use a terminal emulator that supports DTR signaling. See
3.4.4.  Signaling.

3.4.3 Limitations
Not all UART features are implemented in the on-board debugger CDC. The constraints are outlined
here:

• Baud rate: Must be in the range of 1200 bps to 500 kbps. Any baud rate outside this range will be
set to the closest limit without warning. Baud rate can be changed on-the-fly.
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• Character format: Only 8-bit characters are supported.
• Parity: Can be odd, even, or none.
• Hardware flow control: Not supported.
• Stop bits: One or two bits are supported.

3.4.4 Signaling
During USB enumeration, the host OS will start both the communication and data pipes of the CDC
interface. At this point, it is possible to set and read back the baud rate and other UART parameters
of the CDC, but data sending and receiving will not be enabled.

The terminal must assert the DTR signal when it connects to the host. As this is a virtual control
signal implemented on the USB interface, it is not physically present on the board. Asserting the
DTR signal from the host will indicate to the on-board debugger that a CDC session is active.
The debugger will enable its level shifters (if available) and start the CDC data send and receive
mechanisms.

Deasserting DTR in debugger firmware version 1.20 or earlier has the following behavior:
• Debugger UART receiver is disabled, and no further data will be transferred to the host computer
• Debugger UART transmitter will continue to send queued data ready for transfer, but no new

data is accepted from the host computer
• Level shifters (if available) are not disabled, and the debugger CDC TX line remains driven

Deasserting DTR in debugger firmware version 1.21 or later has the following behavior:
• Debugger UART receiver is disabled, and no further data will be transferred to the host computer
• Debugger UART transmitter will continue to send queued data ready for transfer, but no new

data is accepted from the host computer
• Once the ongoing transmission is complete, level shifters (if available) are disabled, and the

debugger CDC TX line will become high-impedance

Remember: Set up the terminal emulator to assert the DTR signal. Without the signal, the
on-board debugger will not send or receive data through its UART.

Tip: The on-board debugger’s CDC TX pin will not be driven until the CDC interface is
enabled by the host computer. Also, there are no external pull-up resistors on the CDC
lines connecting the debugger and the target, meaning the lines are floating during power-
up. The target device may enable the internal pull-up resistor on the pin connected to the
debugger’s CDC TX pin to avoid glitches resulting in unpredictable behavior like framing
errors.

3.4.5 Advanced Use
CDC Override Mode
In ordinary operation, the on-board debugger is a true UART bridge between the host and the
device. However, in certain use cases, the on-board debugger can override the basic Operating
mode and use the CDC TX and RX pins for other purposes.

Dropping a text file into the on-board debugger’s mass storage drive can be used to send characters
out of the debugger’s CDC TX pin. The filename and extension are trivial, but the text file will start
with the characters:
CMD:SEND_UART=
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Debugger firmware version 1.20 or earlier has the following limitations:
• The maximum message length is 50 characters – all remaining data in the frame are ignored
• The default baud rate used in this mode is 9600 bps, but if the CDC is already active or

configured, the previously used baud rate still applies

Debugger firmware version 1.21 and later has the following limitations/features:
• The maximum message length will vary depending on the MSC/SCSI layer timeouts on the host

computer and/or operating system. A single SCSI frame of 512 bytes (498 characters of payload)
is ensured, and files up to 4 KB will work on most systems. The transfer will complete on the first
NULL character encountered in the file.

• The baud rate used is always 9600 bps for the default command:
CMD:SEND_UART=

• Do not use the CDC Override mode simultaneously with data transfer over the CDC/terminal.
If a CDC terminal session is active when receiving a file via the CDC Override mode, it will be
suspended for the duration of the operation and resumed once complete.

• Additional commands are supported with explicit baud rates:
CMD:SEND_9600=

CMD:SEND_115200=

CMD:SEND_460800=

USB-Level Framing Considerations
Sending data from the host to the CDC can be done byte-wise or in blocks, chunked into 64-byte
USB frames. Each frame will be queued for transfer to the debugger’s CDC TX pin. Sending a
small amount of data per frame can be inefficient, particularly at low baud rates, as the on-board
debugger buffers frames but not bytes. A maximum of four 64-byte frames can be active at any
time. The on-board debugger will throttle the incoming frames accordingly. Sending full 64-byte
frames containing data is the most efficient method.

When receiving data on the debugger’s CDC RX pin, the on-board debugger will queue up the
incoming bytes into 64-byte frames, which are sent to the USB queue for transmission to the host
when they are full. Incomplete frames are also pushed to the USB queue at approximately 100 ms
intervals, triggered by USB start-of-frame tokens. Up to eight 64-byte frames can be active at any
time.

An overrun will occur if the host (or the software running on it) fails to receive data fast enough.
When this happens, the last-filled buffer frame recycles instead of being sent to the USB queue, and
a complete data frame will be lost. To prevent this occurrence, the user will ensure that the CDC data
pipe is continuously read, or the incoming data rate will be reduced.

Sending Break Characters
The host can send a UART break character to the device using the CDC, which can be useable
for resetting a receiver state-machine or signaling an exception condition from the host to the
application running on the device.

A break character is defined as a sequence of at least 11 zero bits transmitted from the host to the
device.

Not all UART receivers have support for detecting a break, but a correctly-formed break character
usually triggers a framing error on the receiver.

Sending a break character using the debugger's CDC has the following limitations:
• Sending a break must NOT be done simultaneously, as using the CDC Override mode (drag-and-

drop). Both these functions are temporary states and must be used independently.
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• Sending a break will cause the data currently being sent to be lost. Be sure to wait a sufficient
amount of time to allow all characters in the transmission buffer to be sent (see above section)
before sending the break, which is also in line with expected break character usage: For example,
reset a receiver state-machine after a timeout occurs waiting for returning data to the host.

• The CDC specification allows for debugger-timed breaks of up to 65534 ms in duration to be
requested. For simplicity, the debugger will limit the break duration to a maximum of 11 bit-
durations at its minimum supported baud rate.

• The CDC specification allows for indefinite host-timed breaks. It is the responsibility of the
terminal application/user to release the break state in this case.

Note:  Sending break characters is available in debugger firmware version 1.24 and later.

3.5 Mass Storage Device
The on-board debugger includes a simple Mass Storage Device implementation, which is accessible
for read/write operations via the host operating system to which it is connected.

It provides:
• Read access to basic text and HTML files for detailed kit information and support
• Write access for programming Intel® HEX formatted files into the target device’s memory
• Write access for simple text files for utility purposes

3.5.1 Mass Storage Device Implementation
The on-board debugger implements a highly optimized variant of the FAT12 file system with several
limitations, partly due to the nature of FAT12 itself and optimizations made to fulfill its purpose for
its embedded application.

The Curiosity Nano USB device is USB Chapter 9-compliant as a mass storage device but does
not, in any way, fulfill the expectations of a general purpose mass storage device. This behavior is
intentional.

When using the Windows operating system, the on-board debugger enumerates as a Curiosity Nano
USB Device found in the disk drives section of the device manager. The CURIOSITY drive appears in
the file manager and claims the following available drive letter in the system.

The CURIOSITY drive contains approximately one MB of free space and does not reflect the target
device’s Flash size. When programming an Intel HEX file, the binary data are encoded in ASCII with
metadata providing a vast overhead, so 1 MB is a trivially chosen value for disk size.

It is not possible to format the CURIOSITY drive. The filename may appear in the disk directory listing
when programming a file to the target, which is merely the operating system’s view of the directory
that, in reality, has not been updated. It is not possible to read out the file contents. Removing and
replugging the board will return the file system to its original state, but the target will still contain the
previously programmed application.

Copy a text file starting with “CMD:ERASE” onto the disk to erase the target device.

By default, the CURIOSITY drive contains several read-only files for generating icons as well as
reporting status and linking to further information:

• AUTORUN.ICO – icon file for the Microchip logo

• AUTORUN.INF – system file required for Windows Explorer to show the icon file

• KIT-INFO.HTM – redirect to the development board website

• KIT-INFO.TXT – a text file containing details about the board’s debugger firmware version,
board name, USB serial number, device, and drag-and-drop support

• STATUS.TXT – a text file containing the programming status of the board
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Info: The on-board debugger dynamically updates STATUS.TXT. The contents may not
reflect the correct status as the OS may cache it.

3.5.2 Special Commands
Several utility commands are supported by copying text files to the mass storage disk. The filename
or extension is irrelevant – the command handler reacts to content only.

Table 3-3. Special File Commands
Command Content Description

CMD:ERASE Executes a chip erase of the target

CMD:SEND_UART= Sends a string of characters to the CDC UART. See “CDC Override
Mode.”

CMD:SEND_9600=
CMD:SEND_115200=
CMD:SEND_460800=

Sends a string of characters to the CDC UART at the specified baud
rate. Note that only the baud rates explicitly specified here are
supported. See “CDC Override Mode.” (Debugger firmware v1.25.6
or newer.)

CMD:RESET Resets the target device by entering Programming mode and exiting
Programming mode immediately afterward. The exact timing can
vary according to the programming interface of the target device.
(Debugger firmware v1.25.6 or newer.)

CMD:POWERTOGGLE Powers down the target and restores it after a 100 ms delay. If
external power is provided, this has no effect. (Debugger firmware
v1.25.6 or newer.)

CMD:0V Powers down the target device by disabling the target supply
regulator. If external power is provided, this has no effect. (Debugger
firmware v1.25.6 or newer.)

CMD:1V8 Sets the target voltage to 1.8V. If external power is provided, this has
no effect. (Debugger firmware v1.25.6 or newer.)

CMD:3V3 Sets the target voltage to 3.3V. If providing external power, this has
no effect. (Debugger firmware v1.25.6 or newer.)

Info: The content sent to the mass storage emulated disk triggers the commands listed
here and provides no feedback in the case of either success or failure.

3.6 Data Gateway Interface (DGI)
Data Gateway Interface (DGI) is a USB interface transporting raw and timestamped data between
on-board debuggers and host computer-based visualization tools. MPLAB Data Visualizer is used on
the host computer to display any debug GPIO data. It is available as a plug-in for MPLAB X IDE or a
stand-alone application that can be used in parallel withMPLAB® X IDE.

Although DGI encompasses several physical data interfaces, the PIC18F56Q24 Curiosity Nano
implementation includes logic analyzer channels:
• One debug GPIO channel (also known as DGI GPIO)

3.6.1 Debug GPIO
Debug GPIO channels are timestamped digital signal lines connecting the target application to a
host computer visualization application. They are typically used to plot low-frequency events on a
time axis, such as when given Application state transitions occur.

https://www.microchip.com/en-us/development-tools-tools-and-software/embedded-software-center/mplab-data-visualizer
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The figure below shows the monitoring of the Digital state of a mechanical switch connected to a
debug GPIO in the MPLAB Data Visualizer.

Figure 3-3. Monitoring Debug GPIO with MPLAB Data Visualizer

Debug GPIO channels are timestamped, so the resolution of DGI GPIO events is determined by the
resolution of the DGI Timestamp module.

Important: Although signal bursts of higher frequency can be captured, the frequency
range of signals for which debug GPIO can be used is up to about 2 kHz. Attempting to
capture signals above this frequency will result in data saturation and overflow, which may
cause the DGI session to be aborted.

3.6.2 Timestamping
When captured by the debugger, DGI sources are timestamped. The timestamp counter
implemented in the Curiosity Nano debugger increments at a 2 MHz frequency, providing a
timestamp resolution of a half microsecond.

3.7 Device Configuration Protection
The on-board debugger on the PIC18F56Q24 Curiosity Nano has a protection mechanism intended
to prevent the MCU from being rendered unrecoverable, especially when using drag-and-drop
programming. Disabling the programming and debugging interface, or permanently locking
memories are features of some MCUs that are not conducive to evaluation on a development kit
platform.

The protection mechanism works by intercepting write operations to the relevant configuration bits
and conditionally masking the addresses and values written.

Info:  The protection mechanism is intended to prevent making accidental irreversible
changes. Users intentionally making irreversible changes do so at their own risk.
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Info:  The available feature-set and corresponding prevention mechanism depend on the
device. Check the data sheet for further information.

The protection mechanism can be disabled for users wanting to have the complete experience of
given features that require irreversible changes. Doing this will result in permanent changes.

The pydebuggerconfig package distributed on pypi.org can be used to tweak many aspects of the
debugger, including configuration protection. This procedure requires the installation of a recent
release of Python 3 and the pydebuggerconfig package in that environment.

Step 1: Current status

Determine whether protection is currently enabled by executing:
pydebuggerconfig read

Then check for the section:
Register TARGET_DEBUG_FEATURES:   0x0F (15)  # Program/debug features
                                      bit 0, SINGLE_DEVICE: 1 # Single-device
                                      bit 1, PROG_ENABLED: 1 # Programming
                                      bit 2, DEBUG_ENABLED: 1 # Debug
                                      bit 3, FUSE_PROTECTION: 1 # Fuse protection

A FUSE_PROTECTION value of '1' indicates that protection is in place.

Step 2: Modifying the protection setting

Calculate the desired setting for TARGET_DEBUG_FEATURES by setting FUSE_PROTECTION to '0'.
Replace the current value in the TARGET_DEBUG_FEATURES register by executing, for example:
pydebuggerconfig replace -r TARGET_DEBUG_FEATURES=0x07

To verify that the new value is set, repeat the process from step 1 and then toggle power on the kit.
All protection mechanisms are now disabled.

Step 3: Restoring protection

Protection can be re-enabled either by repeating step 2 with the initial value or using the factory-
restore function by executing:
pydebuggerconfig restore

Important:  The restore function will only restore any altered kit configuration settings
that have changed since manufacturing, which is done by restoring a copy of the kit
configuration settings stored internally on the debugger. This operation does not affect
the MCU and will not undo any irreversible changes that may have been made to its
configuration.

https://pypi.org/project/pydebuggerconfig/
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4. Hardware Implementation
LED, Mechanical Switch, Power Supply

4.1 Crystal
The PIC18F56Q24 Curiosity Nano Board has a 32.768 kHz crystal footprint for standard 3.2 mm by
1.5 mm surface mount crystals with two terminals. The crystal footprint is not connected to the
PIC18F56Q24 by default, as the GPIOs are routed to the edge connector.

Figure 4-1. 32.768 kHz Crystal Block Diagram
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Table 4-1. Crystal Connections
PIC18F56Q24 Pin Function Shared Functionality

RA7 OSC1 Edge connector

RA6 OSC2 Edge connector

Some hardware modifications are required to use a crystal with the PIC18F56Q24.
• The two I/O lines routed to the edge connector must be disconnected to reduce the chance of

contention to the crystal and to remove excessive capacitance on the lines
• Disconnect the edge connector by cutting the two cut straps on the bottom side of the board,

J107 and J108. Marked RA6 and RA7 in the silkscreen
• Connect the crystal by soldering on a solder blob on each circular solder point next to the crystal

on the top side of the board, J109 and J110
• Add suitable capacitors to C104 and C105
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Figure 4-2. Crystal Cut Straps
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The crystal has a cut strap (J111), which can be used to measure the oscillator safety factor and is
done by cutting the strap and adding a 0402 SMD resistor across the strap. The AN2648 application
note from Microchip contains more information about oscillator allowance and safety factors.

4.2 Multi-Voltage I/O
The PIC18F56Q24 features one MVIO domain powered by VDDIO2. Pins PC3 through PC6 and the pins
in PORTD are powered through VDDIO2. The I/O pins connected to the MVIO feature are powered
only by the additional VDDIO2 pin. If no power is supplied to this power pin, the associated I/O pins
will not function.

VCC_TARGET supplies VDDIO2 by default. Removing the 0Ω resistor R105 disconnects the default
power connection. After the removal, an external power supply can power the MVIO pins through
the associated 1x2-100mil footprint ( J107). The block diagram below details the connections to the
VDDIO2 power domain.

Tip: The VDDIO2 supply voltage can go below the device’s minimum VDD of 1.8V, with a
minimum voltage of 1.62V.

Figure 4-3. MVIO Block Diagram
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https://ww1.microchip.com/downloads/en/Appnotes/AN2648-Selecting_Testing-32KHz-Crystal-Osc-for-AVR-MCUs-00002648B.pdf
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Figure 4-4. VDDIO2 Connections

J112

R105

WARNING Before any hardware modifications, ensure the board is disconnected from the USB or
external power.

Disconnecting VDDIO2:
• Disconnect VDDIO2 from VCC_TARGET by removing resistor R105
• Connect a new power supply to VDDIO2 and ground at J112

WARNING J112 does not have reverse polarity protection. Applying voltage to the wrong pin may
cause permanent damage to the board.

WARNING Applying an external voltage to VDDIO2 without removing the resistor may cause permanent
damage to the board!

4.3 LED
One yellow user LED is available on the PIC18F56Q24 Curiosity Nano board. Either GPIO or PWM can
control it. Driving the connected I/O line to GND can also activate the LED.

Figure 4-5. PIC18F56Q24 Curiosity Nano LED0 Block Diagram
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Table 4-2. LED Connection
PIC18F56Q24 Pin Function Shared Functionality

RF2 Yellow LED0 Edge connector

4.4 Mechanical Switch
The PIC18F56Q24 Curiosity Nano board has one mechanical switch - a generic user-configurable
switch. Pressing it will connect the I/O pin to ground (GND).

Figure 4-6. PIC18F56Q24 Curiosity Nano SW0 Block Diagram
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Tip: There is no externally connected pull-up resistor on the switch. Enable the internal
pull-up resistor on Pin RF3 to use it.

Table 4-3. Mechanical Switch Connection
PIC18F56Q24 Pin Description Shared Functionality

RF3 User switch (SW0) Edge connector, On-board debugger

4.5 Power Supply
The USB port powers the board. The input power is delayed to allow USB cable oscillations to die
out. The delay is about 1 ms. VBUS is further limited to a 2 V/ms slew rate and is current limited to
500 mA by U202 (MIC2008).

Tip: Changing the values for C206 and R211 can alter the slew rate and current limit set by
U202.

The power supply consists of two LDO regulators, one to generate 3.3V for the on-board debugger
and an adjustable LDO regulator for the target PIC18F56Q24 microcontroller and its peripherals. The
voltage from a USB connector can vary between 4.4V and 5.25V (according to the USB specification)
and will limit the maximum voltage supplied to the target. The figure below shows the entire power
supply system on the PIC18F56Q24 Curiosity Nano.

https://www.microchip.com/en-us/product/MIC2008
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Figure 4-7. Power Supply Block Diagram
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4.5.1 Cut Straps
All power and debugging signals are connected to the target by default. The following cut straps are
available to take measurements or separate the debugger from the target:
• Target Power Strap (J201)
• Power Supply Strap (J200)
• Debugger Pins (J101, J102, J104, J105, J106)

Figure 4-8. Common Curiosity Nano Cut Straps
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4.5.2 Target Regulator
The target voltage regulator is a MIC5353 variable output LDO. The on-board debugger can adjust
the voltage output supplied to the board target section by manipulating the MIC5353’s feedback
voltage. The hardware implementation is limited to an approximate voltage range from 1.7V to 5.1V.
Additional output voltage limits are configured in the debugger firmware to ensure that the output
voltage never exceeds the hardware limits of the PIC18F56Q24 microcontroller. The voltage limits
configured in the on-board debugger on PIC18F56Q24 Curiosity Nano are 1.8–5.5V.
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Info: The factory default target voltage is 3.3V. The project properties in MPLAB® X IDE can
change it. Any change to the target voltage is persistent, even after a power toggle. The
resolution is less than 5 mV but may be limited to 10 mV by the adjustment program.

Info: The voltage settings setup in MPLAB® X IDE is not applied immediately to the
board. Like clicking the Refresh Debug Tool Status button in the project dashboard tab
or programming/reading program memory, the new voltage setting is applied to the board
when accessing the debugger.

Info: There is an easy option to adjust the target voltage with a drag-and-drop command
text file to the board, which supports a set of commonly used target voltages. See section
3.5.2.  Special Commands for further details.

MIC5353 supports a maximum current load of 500 mA. It is an LDO regulator in a small package
placed on a small printed circuit board (PCB) and can reach the thermal shutdown condition at
lower loads than 500 mA. The maximum current load depends on the input voltage, the selected
output voltage, and the ambient temperature. The figure below shows the safe operating area for
the regulator, with an input voltage of 5.1V and an ambient temperature of 23°C.

Figure 4-9. Target Regulator Safe Operation Area

The voltage output of the target regulator is continuously monitored (measured) by the on-board
debugger. An error condition will be flagged - and the target voltage regulator will be switched off,
detecting and handling any short-circuit conditions if it is more than 100 mV over/under the set
device voltage. It will also detect and handle if an external voltage, which causes VCC_TARGET to
move outside the voltage setting monitoring window of ±100 mV, is suddenly applied to the VTG pin
without setting the VOFF pin low.
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Info: The on-board debugger has a monitoring window of VCC_TARGET±100 mV, and the
status LED will blink rapidly if the external voltage is under this limit. The on-board
debugger status LED will continue to shine if the external voltage surpasses this limit.
When removing the external voltage, the status LED will start blinking rapidly until the
on-board debugger detects the new situation and turns the target voltage regulator back
on.

4.5.3 External Supply
Instead of the on-board target regulator, an external voltage can power the PIC18F56Q24 Curiosity
Nano. When shorting the Voltage Off (VOFF) pin to the ground (GND) pin, the on-board debugger
firmware disables the target regulator, and it is safe to apply an external voltage to the VTG pin.

It is also safe to apply an external voltage to the VTG pin when no USB cable is plugged into the
DEBUG connector on the board.

The VOFF pin can be tied low/let go at any time, which will be detected by a pin-change interrupt to
the on-board debugger, which controls the target voltage regulator accordingly.

WARNING Applying an external voltage to the VTG pin without shorting VOFF to GND may cause
permanent damage to the board.

WARNING Do not apply any voltage to the VOFF pin. Let the pin float to enable the power supply.

WARNING The absolute maximum external voltage is 5.5V for the on-board level shifters, and the
standard operating condition of the PIC18F56Q24 is 1.8–5.5V. Applying a higher voltage
may cause permanent damage to the board.

Info: The on-board debugger monitors the voltage supplied to the board. If VOFF is not
pulled low and external power is supplied that differs by more than ±100 mV from the
target regulator setting, the on-board debugger will shut off the target regulator and
begin blinking the status LED rapidly, indicating an error condition. Once the input voltage
returns to within ±100 mV of the target regulator setting, the on-board debugger will switch
on the target regulator and stop blinking the status LED.

Programming, debugging, and data streaming are still possible with an external power supply. The
USB cable will power the debugger and signal level shifters. Both regulators, the debugger, and the
level shifters are powered down when the USB cable is removed.

Info: In addition to the power consumed by the PIC18F56Q24 and its peripherals,
approximately 100 µA will be drawn from any external power source to power the on-
board level shifters and voltage monitor circuitry when plugging a USB cable into the
DEBUG connector on the board. When a USB cable is unplugged, some current is used
to supply the level shifter’s voltage pins, having a worst-case current consumption of
approximately 5 µA. Typical values may be as low as 100 nA.
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4.5.4 Power Supply Exceptions
This section sums up most exceptions that can occur with the power supply.

Target Voltage Shuts Down
Not reaching the target voltage setting can happen if the target section draws too much current at
a given voltage and causes the thermal shutdown safety feature of the MIC5353 regulator to kick in.
To avoid this, reduce the current load of the target section.

Target Voltage Setting is Not Reached
The USB input voltage (specified to be 4.4-5.25V) limits the maximum output voltage of the MIC5353
regulator at a given voltage setting and current consumption. If a higher output voltage is needed,
use a USB power source with a higher input voltage or use an external voltage supply on the VTG
pin.

Target Voltage is Different From Setting
An externally applied voltage to the VTG pin without setting the VOFF pin low can cause this. If the
target voltage varies more than 100 mV over/under the voltage setting, the on-board debugger will
detect it, and the internal voltage regulator will shut down. To fix this issue, remove the applied
voltage from the VTG pin, and the on-board debugger will enable the on-board voltage regulator
when the new condition is detected. Note that the PS LED will blink rapidly if the target voltage is
below 100 mV of the setting but will ordinarily turn on when higher than 100 mV above it.

No, or Very Low Target Voltage and PS LED is Blinking Rapidly
A full or partial short circuit can cause this and is a particular case of the issue above. Remove it, and
the on-board debugger will re-enable the on-board target voltage regulator.

No Target Voltage and PS LED is Lit 1
This situation occurs if the target voltage is set to 0.0V. Set the target voltage to a value within the
specified voltage range for the target device to fix this.

No Target Voltage and PS LED is Lit 2
This situation can be the issue when cutting power jumper J200 and/or J201 and setting the target
voltage regulator to a value within the specified voltage range for the target device. To fix this, solder
a wire/bridge between the pads for J200/J201 or add a jumper on J201 if a pin-header is mounted.

VBUS Output Voltage is Low or Not Present
If the VBUS output voltage is low or missing, the reason is probably a high-current drain on VBUS,
and the current limit set by U202 (MIC2008) is tripped and has cut off VBUS completely. Reduce the
current consumption on the VBUS pin to fix this issue.

4.5.5 Low-Power Measurement
Power to the PIC18F56Q24 comes from the on-board power supply and VTG pin through a 100 mil
pin-header marked with “POWER” in silkscreen (J201). To measure the power consumption of the
PIC18F56Q24 and other peripherals connected to the board, cut the Target Power strap (J201) on the
bottom side and connect an ammeter across it.

Tip: A 100-mil pin-header can be soldered into the Target Power strap (J201) footprint for
a simple connection of an ammeter. Place a jumper cap on the pin-header once the
ammeter is no longer needed.

To measure the lowest possible power consumption, follow these steps:
1. Cut the POWER strap with a sharp tool.
2. Solder a 1x2 100 mil pin-header in the footprint.
3. Connect an ammeter to the pin header.

https://www.microchip.com/en-us/product/MIC2008
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4. Write firmware that:
a. Tri-states any I/O connected to the on-board debugger.
b. Sets the microcontroller in its lowest Power sleep mode.

5. Program the firmware into the PIC18F56Q24.

Info: The on-board level shifters will draw a small amount of current even when unused.
Each level shifter has a maximum of 2 μA leakage current. Therefore, the worst-case
maximum current draw for the five on-board level shifters is 10 μA. Prevent leakage
current through an I/O pin connected to a level shifter by keeping the I/O pin tri-stated.
All I/Os connected to the on-board debugger are listed in 3.2.  On-Board Debugger
Connections. The on-board level shifters can be completely disconnected, preventing
leakage, as described in 7.6.  Disconnecting the On-Board Debugger.

4.5.6 VBUS Output Pin
PIC18F56Q24 Curiosity Nano has a VBUS output pin that can be used to power external components
that need a 5V supply. The VBUS output pin is protected by the same start-up delay with a slew
rate and current limiter as the rest of the power supply. A side effect is a voltage drop on the VBUS
output with higher current loads. The chart below shows the VBUS output voltage versus the current
load of the VBUS output.

Figure 4-10. VBUS Output Voltage vs. Current
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5. Revision History
Hardware and Document Revision History.

5.1 Hardware Revision History and Known Issues
This user guide provides information about the latest available revision of the board. The following
sections contain information about known issues, a revision history of older revisions, and how older
revisions differ from the latest revision.

5.1.1 Identifying Product ID and Revision
There are two ways to find the revision and product identifier of the PIC18F56Q24 Curiosity Nano:
The MPLAB X IDE Kit Window or the sticker on the bottom of the PCB.

The Kit Window will pop up when connecting PIC18F56Q24 Curiosity Nano to a computer with
MPLAB X IDE running. The first six digits of the serial number, listed under kit information, contain
the product identifier and revision.

Tip:  If closed, the Kit Window can be opened in MPLAB X IDE through the menu bar
Window > Kit Window.

The same information is found on the sticker on the bottom side of the PCB. Most boards will have
the identifier, revision, serial number, and manufacturing date printed in plain text as 02-nnnn\rr
SN: mmmssssss [Manufacturing date], where “nnnn” is the identifier, “rr” is the revision, "mmm" is
the manufacturer, and "ssssss" is the serial number.

The serial number string has the following format:

"nnnnnnrrmmmssssss"

n = product identifier

r = revision

m = manufacturer

s = serial number

The product identifier for PIC18F56Q24 Curiosity Nano is 02-00868.

5.1.2 Revision 1
Revision 1 is the initially released board revision. It has PIC18F56Q24 rev. A1 mounted.

Known Issue: Some of the initial PIC18F56Q24 Curiosity Nano boards were released without the
demo firmware programmed into the PIC18F56Q24. The firmware project and the compiled hex file
can be found on GitHub.

https://github.com/microchip-pic-avr-examples/pic18f56q24-cnano-demo-fw
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6. Document Revision History
Doc. Rev. Date Comments

A 12/2023 Initial document release
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7. Appendix
Schematic, Assembly Drawing, Adapter Pinout, Programming External MCUs, External Debuggers
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7.1 Schematic
rotatethispage90

Figure 7-1. PIC18F56Q24 Curiosity Nano MCU Schematic rotatethispage90
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Crystal datasheet: 
Ccrystal = 9pF 
max ESR = 70kOhm 
Accuracy ±20ppm 

PIC18F56Q24 datasheet: 
Cxin = 5.0pF 
Cxout = 5.0pF
Maximum Cl = 18pF
Maximum ESR = 100k

Cl ≈ 1/( (1/5.0pF)+ (1/5.0pF) ) ≈ 2.5pF 

Estimated Cpcb = 0.5pF 

Estimated load 
C = 2 (Ccrystal- Cpara - Cpcb) 
C = 2 (9pF - 2.5pF - 0.5pF) 
C = 12.9pF 

Selected in design after verification 
C= 6.8/5.6pF

NOTE on UART/CDC:

RX/TX on the header denotes the 
input/output direction of the signal 
respective to it's source.

CDC TX is output from the DEBUGGER.
CDC RX is input to the DEBUGGER.
TX is output from the TARGET device.
RX is input to the TARGET device.

NOTE on I2C:

No pull-ups on board. Pull-ups must be 
mounted close to client device(s).

PIC18F56Q24
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VDDIO2

J112 can be used to apply external 
power to VDDIO2.
Make sure to remove R105 to
disconnect on-board power before 
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Figure 7-2. PIC18F56Q24 Curiosity Nano Debugger Schematic rotatethispage90

1

1

2

2

3

3

4

4

5

5

6

6

7

7

8

8

D D

C C

B B

A A

PIC18F56Q24 Curiosity Nano

PIC18F56Q24_Curiosity_Nano_Debugger.SchDoc

Project Title

File:

Designed with

PCB Layout Contact:
S. Tanbergmoen

Sheet Title

Debugger

Project Owner:
S. Tanbergmoen

Size A3

EV01E86A
PartNumber: Variant: Default Assembly

3 of 4
2023-11-13SCH #: Date:

Sheet
02-00868 1

PCB #: 04-11947
Rev:
Rev: 1 Altium.com

Interface
SWDICSP™ UPDI
TARGETTARGET

TARGET ADJUSTABLE REGULATOR

TARGET
Signal

UART RX UART RXCDC TX UART RX

VCC_REGULATOR VCC_LEVEL VCC_EDGEVCC_VBUS

EN
1

VIN
3

VOUT
4

ADJ
5

GND
2

BYP
6

EP
7

MIC5353YMT-TR
U200

VOUT
A1

VIN
A2

VOUT
B1

VIN
B2

GND
C1

EN
C2

MIC94163YCS

U201

UART TXCDC RX UART TX UART TX

J200

47k
R201

47k
R200

REG_ENABLE

DAT UPDI SWDATDBG0
GND

47k
R203

GPIOCLK SWCLKDBG1

J201

47k
R204

GND

0.1uF
C201

2.2uF
C200

47k
R202

V
T

G
_E

N

GPIO

VCC_TARGET

SWO/GPIOGPIODBG2
GND

RESET
GND

RESETMCLR
GND

DBG3
GND

-VCC - -
GNDGNDGND

47k
R205

27k
R206

47k
R207

V
B

U
S_

A
D

C

ID PIN

R
E

G
_A

D
JU

ST

VTG_ADC
DAC

33k

R208

VTG_EN

1k

R218 VCC_P3V3

REG_ENABLE

ID_SYS
ID_SYS

VBUS_ADC

DEBUGGER POWER/STATUS LED

DEBUGGER

TP200

TP201

STATUS_LED

SML-P12MTT86R

D200

1k

R215 VCC_P3V3

DEBUGGER TESTPOINT

VCC_MCU_CORE

GND

1uF

C209
GND

GND

TCK
1

GND
2

TDO
3

VTref
4

TMS
5

SRST
6

TESTPOINT ARRAY 2x3 JTAG

J202
VCC_P3V3

SWCLK

VCC_P3V3

SWDIO SRST

0.1uF

C207TP202

TP203

SWCLK

GND

SWDIO

SR
ST

B
O

O
T

PAD
33

PA00
1

PA01
2

PA02
3

PA03
4

G
N

D
10

V
D

D
A

N
A

9

PA04
5

PA05
6

PA06
7

PA07
8

PA
08

11
PA

09
12

PA
10

13
PA

11
14

PA
14

15
PA

15
16

PA16
17

PA17
18

PA18
19

PA19
20

PA22
21

USB_SOF/PA23
22

USB_DM/PA24
23

USB_DP/PA25
24

PA
27

25

R
E

SE
T

N
26

PA
28

27

G
N

D
28

V
D

D
C

O
R

E
29

V
D

D
IN

30

SW
D

C
L

K
/P

A
30

31

SW
D

IO
/P

A
31

32

ATSAMD21E18
U206

VCC_LEVEL

DIR
5

A
3

B
4

GND
2

VCCA
1

VCCB
6

74LVC1T45FW4-7

U209
VCC_P3V3

GND
CDC_TX_CTRL

CDC_TX
CDC_TX

USBD_P S1_0_TX
USBD_N S1_1_RX

VCC_LEVEL

DIR
5

A
3

B
4

GND
2

VCCA
1

VCCB
6

74LVC1T45FW4-7

U208
VCC_P3V3ID_SYS DAC

GND

VTG_ADCCDC_TX_CTRL

CDC_RX_CTRL

S0_0_RXVOFF

CDC_RX
CDC_RX

CDC_RX_CTRL RESERVED
VTG_EN S0_2_TX

1k

R212S0_3_CLKDBG3_CTRL
VCC_LEVEL

DIR
5

A
3

B
4

GND
2

VCCA
1

VCCB
6

74LVC1T45FW4-7

U207
VCC_P3V3

GND
DBG0_CTRL

DBG0
DBG0

GND

VCC_LEVEL

DIR
5

A
3

B
4

GND
2

VCCA
1

VCCB
6

74LVC1T45FW4-7

U205
VCC_P3V3

VCC_P3V3

GND

0.1uF

C202

DBG1_CTRL

GND

DBG1
DBG1

VCC_LEVEL

DIR
5

A
3

B
4

GND
2

VCCA
1

VCCB
6

74LVC1T45FW4-7

U204
VCC_P3V3

D
B

G
2_

G
P

IO

V
B

U
S_

A
D

C

D
B

G
2_

C
T

R
L

R
E

G
_E

N
A

B
L

E

D
B

G
0_

C
T

R
L

D
B

G
1_

C
T

R
L

GND
DBG2_CTRL

DBG2
DBG2

VOFF

DEBUGGER REGULATOR

DBG3 OPEN DRAIN

DBG3
DBG3

VOUT
1

VOUT
2

G
N

D
3

EN
4

NC
5

VIN
6

E
P

7

MIC5528-3.3YMT-TR
U203 VCC_P3V3

1k

R209

3

1
2

DMN65D8LFB-7B
Q200

DBG3_CTRL

GND

2.2uF
C203

47k

R210

GND

GND

DEBUGGER USB-C CONNECTOR

USBD_P
USBD_N

VBUS

VOFF

VBUS SLEW RATE- & CURRENT-LIMIT

EN
4

VIN
6

GND

5

CSLEW
2

VOUT
1

EP

7

ILIMIT
3

MIC2008
U202

VCC_VBUS

470R
R211

3

1
2

CSD25501F3

Q201

0.1uF
C208

47k
R214

4.7uF
C205

2.2uF
C204

GND GND GNDGND GND

2200pF
C206

GND
GND

A1/B12
VBUS

A4/B9

CC1
A5

DP1
A6

DN1
A7

SBU1
A8

GND
B1/A12

VBUS
B4/A9

CC2
B5

DP2
B6

DN2
B7

SBU2
B8

SHIELD
1

SHIELD
2

SHIELD
3

SHIELD
4

KLS1-5409
J203

GNDGND

GND

5.1k
R216

5.1k
R217

VBUS_DELAYED

VBUS_DELAYED

47k
R213

GND

VBUS START-UP DELAY

GND
CNANO Template Revision: 2.2

GND

ADJUSTABLE OUTPUT AND LIMITATIONS: 
- The DEBUGGER can adjust the output voltage of the regulator between 1.25V and 5.1V to the
target.
- The voltage output is limited by the input (USB), which can vary between 4.40V to 5.25V 
- The level shifters have a minimal voltage level of 1.65V and will limit the minimum operating 
voltage allowed for the target to still allow communication.
- The MIC94163 has a minimal volatege level of 1.70V and will limit the minimum voltage
delivered to the target. 
- Firmware configuration will limit the voltage range to be within the the target specification. 

Programming 
connector for factory 
programming of 
Debugger.

SLEW RATE LIMIT: 
- With C206 set to 2200pF, the slew rate of VCC_VBUS is limited to 2 V/ms 
by the power switch MIC2008. 

CURRENT LIMIT: 
- With R211 set to 470ohm, the current through the power switch MIC2008 is 
limited to 500mA.

MIC5528:
Vin: 2.5V to 5.5V
Vout: Fixed 3.3V
Imax: 500mA
Dropout: 260mV @ 500mA

R210 is required to pull the 
Q200 gate to a defined value 
when the U206 is not 
powered

START-UP DELAY:: 
- With C208 set to 0.1uF and R214 set to 
47kohm, the P-MOS is delaying the turn-on of 
VCC_DELAYED by 1ms, compared to VBUS.

"POWER"

"PS"

TP200 and TP201 are MTG Holes in 
the corners of the PCB close to the 
DEBUGGER section labelled "GND" 
on the silkscreen.

"GND"

J200: 
- Cut-strap used for full separation of target power from the level shifters and on-board
regulators. 
- For current measurements using an external power supply, this strap could be cut for more
accurate measurements. Leakage back through the switch is in the micro ampere range. 
J201: 
- For current measurements using the on-board power supply, this strap must be cut and an
ammeter connected across.

MIC5353: 
Vin: 2.6V to 6V 
Vout: 1.25V to 5.1V 
Imax: 500mA 
Dropout (typical): 50mV @ 150mA, 160mV @ 500mA 
Accuracy: 2% initial 
Thermal shutdown and current limit 

Maximum output voltage is limited by the input voltage and 
the dropout voltage in the regulator. (Vmax = Vin - dropout)
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7.2 Assembly Drawing
Figure 7-3. PIC18F56Q24 Curiosity Nano Assembly Drawing Top

49

49

48

48

47

47

46

46

45

45

56

56

55

55

54

54 53

53

52

52

51

51

50

50 44

44

43

43

42

42

41

41

40

40

20

18 20

1918

19

21 22 23 24 25 26 27 28

21 23 25 27
2422 26 28

39 37 35 33
38 36 34

39 38 37 36 35 34

31 29

29

32 30

33 32 31 30

8

8

9

9
10

10

11

11 12

12

1

1
2

2

3

3 4

4
5

5 6

6

7

7

13

13

14

14

15

15

16

16
17

17

2

2

2

2

2

2

2 1

11

2

2

3

2

4 2

1

1

2

7

1

2

30

2

1

2 1

2 1

6
5
4

2
1

3

6
5
4

2
1

3

6
5
4

2
1

3

6
5
4

2
1

3

6
5
4

2
1

3
1

2
3

4
5

6

8
9

10
11

1213
14

15
16

17
18

19
20

21
22

23
24

25
26

27
28

29

31
32

33
34

35
36 37

38
39

40
41

42
43

44
45

46
47

48

1

2

3

4

5

6

7

8

910111213141516

17

18

19

20

21

22

23

24

25 26 27 28 29 30 31 32

33

1

2
1

2

1

12 1

2

1

2

B8

A1/B12

B4/A9

B1/A12

A4/B9

A7

A8

B6

B5

A6

B7

A5

1

2

1

1

2

21

1 2

12 1 2

2

1

2

1 2

2 1

1
2 3

1

2

12

1
2

3

21 21

2

1

1

2

1

2

21

1

2

1 2

1

7

23

654

1 2

12 123

4 5 6

7

2 1 12 2

1
7

4

5

6

3

2

1

1

2

1

2

A2

B2

C2 C1

B1

A1

1 2 21 1 2

1 2

11

3

4 2

1

2
2

1 1

2

2

1

1

2

2

PAC10002 
PAC10001 COC100 

PAC10101 
PAC10102 COC101 

PAC10201 
PAC10202 COC102 

PAC10301 

PAC10302 COC103 

PAC10401 
PAC10402 COC104 

PAC10501 

PAC10502 COC105 

PAC20002 PAC20001 COC200 

PAC20102 PAC20101 COC201 

PAC20201 

PAC20202 COC202 

PAC20302 

PAC20301 COC203 
PAC20401 

PAC20402 

COC204 PAC20501 PAC20502 COC205 PAC20601 PAC20602 

COC206 

PAC20702 PAC20701 COC207 

PAC20802 PAC20801 

COC208 

PAC20902 PAC20901 COC209 

PAD10001 

PAD10002 
COD100 

PAD20001 PAD20002 COD200 

PAJ100029 PAJ100030 

PAJ100027 
PAJ10001 

PAJ100056 PAJ100053 

PAJ100028 

PAJ10002 

PAJ100051 PAJ100050 PAJ100052 PAJ100049 PAJ100048 PAJ100047 PAJ100046 PAJ100045 PAJ100044 PAJ100043 PAJ100042 PAJ100041 PAJ100040 PAJ100039 PAJ100038 PAJ100037 PAJ100036 PAJ100035 PAJ100034 PAJ100033 PAJ100032 PAJ100031 

PAJ10003 PAJ10004 PAJ10005 PAJ10006 PAJ10007 PAJ10008 PAJ10009 PAJ100010 PAJ100011 PAJ100012 PAJ100013 PAJ100014 PAJ100015 PAJ100016 PAJ100017 PAJ100018 PAJ100019 PAJ100020 PAJ100021 PAJ100022 PAJ100023 PAJ100026 PAJ100025 PAJ100024 

PAJ100054 PAJ100055 
COJ100 

PAJ10102 PAJ10101 COJ101 

PAJ10202 PAJ10201 COJ102 

PAJ10302 PAJ10301 COJ103 

PAJ10402 PAJ10401 COJ104 

PAJ10502 PAJ10501 COJ105 

PAJ10602 PAJ10601 COJ106 

PAJ10702 PAJ10701 COJ107 

PAJ10802 PAJ10801 COJ108 PAJ10902 PAJ10901 PAJ10905 COJ109 

PAJ11002 PAJ11001 PAJ11005 COJ110 PAJ11101 PAJ11102 COJ111 

PAJ11202 

PAJ11201 
COJ112 PAJ20001 PAJ20002 COJ200 

PAJ20102 PAJ20101 COJ201 

PAJ20201 
PAJ20202 

PAJ20203 
PAJ20204 

PAJ20205 
PAJ20206 

COJ202 

PAJ20302 

PAJ20301 

PAJ20304 

PAJ20303 

PAJ20300 

PAJ2030B8 

PAJ2030A10B12 

PAJ2030B40A9 

PAJ2030B10A12 

PAJ2030A40B9 

PAJ2030A7 

PAJ2030A8 
PAJ2030B6 

PAJ2030B5 

PAJ2030A6 
PAJ2030B7 

PAJ2030A5 

COJ203 

COLABEL1 

PAQ20000 PAQ20001 

PAQ20002 PAQ20003 COQ200 
PAQ20100 

PAQ20101 
PAQ20102 

PAQ20103 

COQ201 

PAR10001 PAR10002 

COR100 

PAR10102 

PAR10101 

COR101 
PAR10202 

PAR10201 

COR102 

PAR10301 

PAR10302 COR103 PAR10402 

PAR10401 COR104 
PAR10502 

PAR10501 

COR105 
PAR20001 
PAR20002 COR200 

PAR20101 
PAR20102 COR201 

PAR20201 PAR20202 COR202 

PAR20301 

PAR20302 COR203 

PAR20401 PAR20402 COR204 

PAR20501 
PAR20502 COR205 

PAR20601 
PAR20602 COR206 

PAR20702 

PAR20701 COR207 

PAR20801 PAR20802 COR208 

PAR20901 PAR20902 COR209 

PAR21001 PAR21002 COR210 

PAR21102 PAR21101 

COR211 

PAR21201 

PAR21202 COR212 PAR21301 
PAR21302 COR213 

PAR21401 
PAR21402 

COR214 

PAR21501 PAR21502 COR215 

PAR21601 PAR21602 

COR216 
PAR21702 PAR21701 COR217 PAR21801 PAR21802 COR218 

PASW10003 

PASW10004 PASW10002 

PASW10001 
COSW100 

PATP20001 COTP200 

PATP20101 COTP201 

PATP20201 COTP202 

PATP20301 COTP203 

PAU10007 

PAU100030 

PAU10001 PAU10002 PAU10003 PAU10004 PAU10005 PAU10006 PAU10008 PAU10009 PAU100010 PAU100011 PAU100012 PAU100013 PAU100014 PAU100015 PAU100016 PAU100017 PAU100018 PAU100019 PAU100020 PAU100021 PAU100022 PAU100023 PAU100024 

PAU100025 PAU100026 PAU100027 PAU100028 PAU100029 
PAU100031 PAU100032 PAU100033 PAU100034 PAU100035 PAU100036 PAU100037 PAU100038 PAU100039 PAU100040 PAU100041 PAU100042 PAU100043 PAU100044 PAU100045 PAU100046 PAU100047 PAU100048 

COU100 

PAU20007 
PAU20004 

PAU20005 
PAU20006 

PAU20003 

PAU20002 
PAU20001 COU200 

PAU2010A2 

PAU2010B2 

PAU2010C2 PAU2010C1 

PAU2010B1 
PAU2010A1 

COU201 
PAU20200 PAU20201 

PAU20207 
PAU20202 PAU20203 

PAU20206 PAU20205 PAU20204 

COU202 
PAU20301 PAU20302 PAU20303 

PAU20304 PAU20305 PAU20306 
PAU20307 COU203 

PAU20406 
PAU20405 

PAU20404 

PAU20402 
PAU20401 

PAU20403 
COU204 

PAU20506 
PAU20505 

PAU20504 

PAU20502 
PAU20501 

PAU20503 
COU205 

PAU20601 

PAU20602 

PAU20603 
PAU20604 

PAU20605 

PAU20606 
PAU20607 

PAU20608 

PAU20609 PAU206010 PAU206011 PAU206012 PAU206013 PAU206014 PAU206015 PAU206016 
PAU206017 

PAU206018 
PAU206019 
PAU206020 

PAU206021 
PAU206022 
PAU206023 

PAU206024 

PAU206025 PAU206026 PAU206027 PAU206028 PAU206029 PAU206030 PAU206031 PAU206032 

PAU206033 
COU206 

PAU20706 
PAU20705 

PAU20704 

PAU20702 
PAU20701 

PAU20703 
COU207 

PAU20806 

PAU20805 

PAU20804 

PAU20802 

PAU20801 

PAU20803 
COU208 

PAU20906 
PAU20905 

PAU20904 

PAU20902 
PAU20901 

PAU20903 
COU209 

PAY10002 

PAY10001 
COY100 

Figure 7-4. PIC18F56Q24 Curiosity Nano Assembly Drawing Bottom
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7.3 Curiosity Nano Base for Click boards™
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7.4 Programming External Microcontrollers
Use the on-board debugger on PIC18F56Q24 Curiosity Nano to program and debug microcontrollers
on external hardware.

7.4.1 Supported Devices
All external AVR® microcontrollers with the UPDI interface can be programmed and debugged with
the on-board debugger with Microchip Studio.

External SAM microcontrollers having a Curiosity Nano Board can be programmed and debugged
with the on-board debugger with Microchip Studio.

PIC18F56Q24 Curiosity Nano can program and debug external PIC18F56Q24 microcontrollers with
MPLAB X IDE.

7.4.2 Software Configuration
No software configuration is required to program and debug the same device mounted on the
board.

To program and debug a different microcontroller than the one mounted on the board, configure
Microchip Studio to allow an independent selection of devices and programming interfaces.

1. Navigate to Tools > Options through the menu system at the application top.
2. Select the Tools > Tool settings category in the options window.
3. Set the Hide unsupported devices option to False.

Figure 7-6. Hide Unsupported Devices

Info:  Microchip Studio allows any microcontroller and interface to be selected when the
Hide unsupported devices setting is set to False - also microcontrollers and interfaces not
supported by the on-board debugger.
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7.4.3 Connecting to External Microcontrollers
The figure and table below show where to connect the programming and debugging signals to
program and debug external microcontrollers. The on-board debugger can supply power to the
external hardware or use an external voltage reference for its level shifters. Read more about the
power supply in 4.5.  Power Supply.

The on-board debugger and level shifters actively drive data and clock signals used for programming
and debugging (DBG0, DBG1, and DBG2). Pull-down resistors are required on the ICSP™ data and
clock signals to debug PIC® microcontrollers. All other interfaces are functional with or without
pull-up or pull-down resistors.

DBG3 is an open-drain connection and requires a pull-up resistor to function.

PIC18F56Q24 Curiosity Nano has pull-down resistors R100 and R101 connected to the ICSP data
and clock signal (DBG0 and DBG1). A pull-up resistor R102 is connected to the MCLR signal (DBG3).
7.2.  Assembly Drawing in the appendix shows the location of pull resistors.

Remember: 
• Connect GND and VTG to the external microcontroller
• Tie the VOFF pin to GND if the external hardware has a power supply
• Make sure there are pull-down resistors on the ICSP data and clock signals (DBG0 and

DBG1) to support the debugging of PIC microcontrollers

Figure 7-7. Curiosity Nano Standard Pinout
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Table 7-1. Programming and Debugging Interfaces
Curiosity Nano Pin UPDI ICSP™ SWD

DBG0 UPDI DATA SWDIO

DBG1 — CLK SWCLK

DBG2 — — —

DBG3 — MCLR RESET

7.5 Connecting External Debuggers
Even though there is an on-board debugger, external debuggers can be connected directly to the
PIC18F56Q24 Curiosity Nano to program/debug the PIC18F56Q24. When not actively used, the
on-board debugger keeps all the pins connected to the PIC18F56Q24 and board edge in tri-state.
Therefore, the on-board debugger will not interfere with any external debug tools.
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Figure 7-8. Connecting the MPLAB® PICkit™ 5 In-Circuit Debugger/Programmer to PIC18F56Q24 Curiosity Nano
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CAUTION The MPLAB® PICkit™ 5 In-circuit Debugger/Programmer can deliver high voltage on the
MCLR pin. High voltage can permanently damage R209. If R209 is broken, the on-board
debugger cannot enter the programming mode of the PIC18F56Q24 and will typically fail at
reading the device ID.

CAUTION To avoid contention between the external debugger and the on-board debugger, do not
start any programming/debug operation with the on-board debugger through MPLAB® X
IDE or mass storage programming while the external tool is active.

7.6 Disconnecting the On-Board Debugger
The on-board debugger and level shifters can be disconnected from the PIC18F56Q24.

The power supply block diagram (Figure 4-7) shows all connections between the debugger and the
PIC18F56Q24. The signal names are also printed in silkscreen on the top or bottom side of the
board.

To disconnect the debugger, cut the GPIO straps shown in 4.5.1.  Cut Straps.
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Attention: Cutting the GPIO straps to the on-board debugger will disable the virtual serial
port, programming, debugging, and data streaming. Cutting the power supply strap will
disconnect the on-board power supply.

Tip: Reconnect any cut connection by using solder. Alternatively, mount a 0Ω 0402 resistor.

Tip: When the debugger is disconnected, an external debugger can be connected to
the holes. 7.5.  Connecting External Debuggers describes how to connect an external
debugger.
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Microchip Information
The Microchip Website
Microchip provides online support via our website at www.microchip.com/. This website is used to
make files and information easily available to customers. Some of the content available includes:

• Product Support – Data sheets and errata, application notes and sample programs, design
resources, user’s guides and hardware support documents, latest software releases and archived
software

• General Technical Support – Frequently Asked Questions (FAQs), technical support requests,
online discussion groups, Microchip design partner program member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip press releases,
listing of seminars and events, listings of Microchip sales offices, distributors and factory
representatives

Product Change Notification Service
Microchip’s product change notification service helps keep customers current on Microchip
products. Subscribers will receive email notification whenever there are changes, updates, revisions
or errata related to a specified product family or development tool of interest.

To register, go to www.microchip.com/pcn and follow the registration instructions.

Customer Support
Users of Microchip products can receive assistance through several channels:

• Distributor or Representative
• Local Sales Office
• Embedded Solutions Engineer (ESE)
• Technical Support

Customers should contact their distributor, representative or ESE for support. Local sales offices are
also available to help customers. A listing of sales offices and locations is included in this document.

Technical support is available through the website at: www.microchip.com/support

Microchip Devices Code Protection Feature
Note the following details of the code protection feature on Microchip products:

• Microchip products meet the specifications contained in their particular Microchip Data Sheet.
• Microchip believes that its family of products is secure when used in the intended manner, within

operating specifications, and under normal conditions.
• Microchip values and aggressively protects its intellectual property rights. Attempts to breach the

code protection features of Microchip product is strictly prohibited and may violate the Digital
Millennium Copyright Act.

• Neither Microchip nor any other semiconductor manufacturer can guarantee the security of its
code. Code protection does not mean that we are guaranteeing the product is “unbreakable”.
Code protection is constantly evolving. Microchip is committed to continuously improving the
code protection features of our products.

Legal Notice
This publication and the information herein may be used only with Microchip products, including
to design, test, and integrate Microchip products with your application. Use of this information
in any other manner violates these terms. Information regarding device applications is provided
only for your convenience and may be superseded by updates. It is your responsibility to ensure

https://www.microchip.com/
https://www.microchip.com/pcn
https://www.microchip.com/support
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that your application meets with your specifications. Contact your local Microchip sales office for
additional support or, obtain additional support at www.microchip.com/en-us/support/design-help/
client-support-services.

THIS INFORMATION IS PROVIDED BY MICROCHIP "AS IS". MICROCHIP MAKES NO REPRESENTATIONS
OR WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY
OR OTHERWISE, RELATED TO THE INFORMATION INCLUDING BUT NOT LIMITED TO ANY IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY, AND FITNESS FOR A PARTICULAR
PURPOSE, OR WARRANTIES RELATED TO ITS CONDITION, QUALITY, OR PERFORMANCE.

IN NO EVENT WILL MICROCHIP BE LIABLE FOR ANY INDIRECT, SPECIAL, PUNITIVE, INCIDENTAL, OR
CONSEQUENTIAL LOSS, DAMAGE, COST, OR EXPENSE OF ANY KIND WHATSOEVER RELATED TO THE
INFORMATION OR ITS USE, HOWEVER CAUSED, EVEN IF MICROCHIP HAS BEEN ADVISED OF THE
POSSIBILITY OR THE DAMAGES ARE FORESEEABLE. TO THE FULLEST EXTENT ALLOWED BY LAW,
MICROCHIP'S TOTAL LIABILITY ON ALL CLAIMS IN ANY WAY RELATED TO THE INFORMATION OR
ITS USE WILL NOT EXCEED THE AMOUNT OF FEES, IF ANY, THAT YOU HAVE PAID DIRECTLY TO
MICROCHIP FOR THE INFORMATION.

Use of Microchip devices in life support and/or safety applications is entirely at the buyer's risk,
and the buyer agrees to defend, indemnify and hold harmless Microchip from any and all damages,
claims, suits, or expenses resulting from such use. No licenses are conveyed, implicitly or otherwise,
under any Microchip intellectual property rights unless otherwise stated.

Trademarks
The Microchip name and logo, the Microchip logo, Adaptec, AVR, AVR logo, AVR Freaks, BesTime,
BitCloud, CryptoMemory, CryptoRF, dsPIC, flexPWR, HELDO, IGLOO, JukeBlox, KeeLoq, Kleer,
LANCheck, LinkMD, maXStylus, maXTouch, MediaLB, megaAVR, Microsemi, Microsemi logo, MOST,
MOST logo, MPLAB, OptoLyzer, PIC, picoPower, PICSTART, PIC32 logo, PolarFire, Prochip Designer,
QTouch, SAM-BA, SenGenuity, SpyNIC, SST, SST Logo, SuperFlash, Symmetricom, SyncServer,
Tachyon, TimeSource, tinyAVR, UNI/O, Vectron, and XMEGA are registered trademarks of Microchip
Technology Incorporated in the U.S.A. and other countries.

AgileSwitch, ClockWorks, The Embedded Control Solutions Company, EtherSynch, Flashtec, Hyper
Speed Control, HyperLight Load, Libero, motorBench, mTouch, Powermite 3, Precision Edge,
ProASIC, ProASIC Plus, ProASIC Plus logo, Quiet-Wire, SmartFusion, SyncWorld, TimeCesium,
TimeHub, TimePictra, TimeProvider, and ZL are registered trademarks of Microchip Technology
Incorporated in the U.S.A.

Adjacent Key Suppression, AKS, Analog-for-the-Digital Age, Any Capacitor, AnyIn, AnyOut,
Augmented Switching, BlueSky, BodyCom, Clockstudio, CodeGuard, CryptoAuthentication,
CryptoAutomotive, CryptoCompanion, CryptoController, dsPICDEM, dsPICDEM.net, Dynamic
Average Matching, DAM, ECAN, Espresso T1S, EtherGREEN, EyeOpen, GridTime, IdealBridge,
IGaT, In-Circuit Serial Programming, ICSP, INICnet, Intelligent Paralleling, IntelliMOS, Inter-Chip
Connectivity, JitterBlocker, Knob-on-Display, MarginLink, maxCrypto, maxView, memBrain, Mindi,
MiWi, MPASM, MPF, MPLAB Certified logo, MPLIB, MPLINK, mSiC, MultiTRAK, NetDetach, Omniscient
Code Generation, PICDEM, PICDEM.net, PICkit, PICtail, Power MOS IV, Power MOS 7, PowerSmart,
PureSilicon, QMatrix, REAL ICE, Ripple Blocker, RTAX, RTG4, SAM-ICE, Serial Quad I/O, simpleMAP,
SimpliPHY, SmartBuffer, SmartHLS, SMART-I.S., storClad, SQI, SuperSwitcher, SuperSwitcher II,
Switchtec, SynchroPHY, Total Endurance, Trusted Time, TSHARC, Turing, USBCheck, VariSense,
VectorBlox, VeriPHY, ViewSpan, WiperLock, XpressConnect, and ZENA are trademarks of Microchip
Technology Incorporated in the U.S.A. and other countries.

SQTP is a service mark of Microchip Technology Incorporated in the U.S.A.

The Adaptec logo, Frequency on Demand, Silicon Storage Technology, and Symmcom are registered
trademarks of Microchip Technology Inc. in other countries.

GestIC is a registered trademark of Microchip Technology Germany II GmbH & Co. KG, a subsidiary
of Microchip Technology Inc., in other countries.

https://www.microchip.com/en-us/support/design-help/client-support-services
https://www.microchip.com/en-us/support/design-help/client-support-services
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Quality Management System
For information regarding Microchip’s Quality Management Systems, please visit
www.microchip.com/quality.
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